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Introduction

This document will describe the installation process for Materials Control MCweb version
8.8.00.xx.

General Requirements:

Internet Information Services (lI1S) > 6.0

Microsoft .NET Framework 2.0 (including all service packs and hotfixes)
Microsoft .NET Framework 3.5 (including all service packs and hotfixes)

Note: If the .NET Framework was installed before the IIS, you need to register

ASP.NET. Execute %windir%\Microsoft. NET\Framework\v2.0.50727\aspnet_regiis -i from
the command line.

Supported RDBMS:

Oracle 10gR2 (please find additional settings in the Troubleshoot section)
Oracle 11gR2

The Oracle Client must be installed and functional.
Required Installation Files:

e MCweb vX.X.X.X .zip
0 MCweb.Application
o MCweb.Config
o Infragistics
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Setup:

Extract the above mentioned zip into temporary folders.

Creation of Directories:
Go to c:\inetpub\wwwroot and create the required folders for the application (e.g. MCweb)

e c:\inetpub\wwwroot\aspnet_client
0 required for the asp.net client

e c:\inetpub\wwwroot\MCweb
0 required for the main web application

[Wwewroot =loix|
‘o(_)o‘  Computer + Local Disk (C:) v inetpub + wwwroot + + K23 [ search wwroct D)
Organize v  Indudeinlibrary +  Sharewith + Bun  New folder = = E;I .@

P " : 5
S Favorites =1 Mame Date modified | Type Size | |
Bl Desktop aspnet_dient 16.04.2013 09:50 File folder
4 Downloads MCweb 16.04.201308:41  File folder
£ RecentPl
it &isstart 12.04.201310:55  HTML Document 1KB
. 3 | welcome 12.04.2013 10:55 PMNG image 131KB
4 Libraries e
3 Documents
fJ‘. Music
= Pictures
E Videos
8 Computer
£, Local Disk (C:) -
El

4 ftems

Web Service Directory:

Copy contents of mcweb.Application to c:\inetpub\wwwroot\ MCweb
Copy contents of mcweb.Config to c:\inetpub\wwwroot\ MCweb

The content of both folders must be copied into the same folder.
e “MCweb.Application” contains the non-static files.
e “MCweb.Config” contains the static files for the installation.
e “MCweb.Config” will probably overwrite some files of “MCweb.Application”.
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‘@‘ o‘ . = Computer - Local Disk (C:) = inetpub = wwwroot ~ MCweb ~ - ml Search MCweb
Organize v Indudeinlbrary v  Sharewith v Burn  New folder
B 4 wwwroot ;I Mame = Date modified | Type Size
| aspnet_dient
| bin 16.04.2013 10:07 File folder
=B
| bin . Common 16.04.2013 10:07 File folder
|| Comman | Info 16.04,2013 10:07 File folder
I Info | Maintenance 16.04.2013 10:07 File folder
g M . MasterData 16.04.2013 10:07 File folder
i Mast=Data | Production 16.04.201310:07  File folder
| Production -
|| Properties 16.04,2013 10:07 File folder
.. Properties
Purchase | Purchase 16.04.2013 10:07 File folder
|| Store |\ Store 16.04.2013 10:07 File folder
I Perflogs || AssemblyInfo.aspx 07.06.2011 13:30 ASPY File 2KB
| Program Files | changelog 12.04.2013 14:26 Text Document 500 KB
Ji Program Files (x85) 2| Default 07.11.201208:18  HTML Document 1KB
M L temn B - E
22 items

T—

web.config Settings

In older versions a tool named as “WebConfig Wizard” was used to define the
configuration settings.

It is no longer recommended to use this tool, but to edit the configuration file manually.

The configuration file is named web.config and can be found in the MCweb installation
root directory.

Open the file with a standard editor (i.e. Notepad):

=101x]
Fle Edt Format e
<7xm] version="1.0"7> -
«conh?:lratmr_u
<configsectionss

<sectionGroup name="system. wcb cxtcnswns type="System. wcb Lonhqurahm bystwcbi.xtcnnonsbccuuﬂ(.rolln. System. web. l.xtcn:nons. version=3.5.0.0,
<sectionGroup name="scri “System. web. Configur gSectionGroup, System.web.Extensions, version=3,5.0.0, Cultures= neutral, Pub
chectionGroup names" 'rr ngwebServicessectionGroup, System. web. Extensi version=1.5
<section name=' alization" type="System stinglsonSerializationSection, System.web.Ext
i rofileservice” type= system. weh. Cnﬂﬁ |rar1nn scriptingProfileServicesection, System.web Extensions, Vers 5.0.0, Cultire:
uthenticationservice” type= system.web.Configuration.SeriptingAuthenticationSeriicesection, Systes,web.Extensions, versien=3,:
r«sectlon name="roleservice” type="System.web.Configuration.ScriptingRolesServiceSection, System. Web.Extensions, Version=3.5.0.0, Culturesneutr:
«/sectionGroups
;scchon name="scriptResourcedandler™ type="System.web.Configuration.ScriptingScriptiesourcedandlersection, System.web. Extensions, version=3.5.(
</sectionGroup>
«/sectionGroups
<section names"
</configSections>
<infragistics.web imagelirectory="~/../ig_common/images" javascriptDirectory="-/../ig_common/20003CLRIS/scripts” />

\l(r\. l pes"Sys tem_ wWeb. Lnufu Cultur

infragistics.web” type="System.Configuration.SingleTagSectionHandler System,  Versions=1.0.3300.0, Culturesneutral, PublicKeyTokenst

xpirationfage” value="Common/forms/SessionExpired. him™/>
el Fathroﬁoot value="../.."f>
<l-- See help 3)
Zadd key="Logath® value="c: /tenp"/>
<l-- Place to store error logs --=
cadd key="ImagePath” value="Common/Images"/>
<!-- Normal images of MCweb --»
<add key="AppImagePath” value="Common/AppImages" />
<!-- Images needed for the menus--»
<add key="ImagePathlIs” value="../Pictures”/>

stored by the user via the application --»
cumentPathIIs" v /Documents” />
“ wia the application --»
ke er service” />
- ,rgedulsr working directory--—-

<add ksy- lllwlnamngnar value="true" />

wl== "frug" /" , /freplace the please wait msg into the new one (in style of the MCweb menubar)--=
<add 'key— Flher:\hgn value="Tleft"

<! experimental key if filter buttons refresh & sort are left or right aligned--=

<add key="PROFILE" value="TbvE, ini”

<l-- the profile to wse. normally fbvs.ini --»

<add key="DbBrand” value="ORACLE" /=

<l-- Oln('le- - -
o .r'
A

[ gy

This file controls the entire behaviour of your MCweb application.
Below you can find the list of the keys which must be checked/adjusted:

e Temporary Directory
0 <add key="LogPath" value="c:/temp"/>
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Make sure that the specified directory exists.

Picture Storage Directory
0 <add key="ImagePathllS" value="../Pictures"/>
Make sure that the specified directory exists inside the folder \wwwroot\.

Document Storage Directory
0 <add key="DocumentPathllS" value="../Documents"/>
Make sure that the specified directory exists inside the folder \wwwroot\.

Database Profile
0 <add key="PROFILE" value="fbv8.ini"/>
This value must be set to fbv8.ini in order to load the correct configuration
parameters from the database.

DB Brand
0 <add key="DbBrand" value="ORACLE"/>
This value must be set to ORACLE, regardless of the Oracle version

DB User
0 <add key="DbUser" value="mcdata"/>
Please specify here the Oracle DB user nhame.

DB Server
0 <add key="SERVER" value="Vv8"/>
Define in here the Instance/SID name of your Oracle Database

Password

0 <add key="PASSWORD" value="micros"/>
The Password of the Oracle User is needed in here (i.e. micros). As this
password is written in clear text in the sample file we strongly recommend to
consider the encryption functionality described in the manual
“140_MCweb_Password_Encryption” (for version 8.7.00.x and higher)..

Organisations
0 <add key="ORGANISATIONS" value="mcdata"/>
0 This value should mirror the setting “DbUser”
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Infragistics Directory:

Copy contents of the Infragistics to the folder c:\inetpub\wwwroot\aspnet_client
(Necessary once only for all different MCweb Installations on one machine).
Please ensure that the latest version of the Infragistics is used.

B aspnet_client =13l x|
e 1l
‘qu‘ .~ Computer ~ Local Disk {C:) = inetpub ~ wwwroot ~ aspnet_client - - ml Search aspret_dient [‘J
Organize * Indudeinlibrary =  Sharewith ¥ Burn  New folder = E;l @
J logs Elre Date modified |Type Size | |
. infragistics 16,04,2013 10:06 File folder
. system_web 16.04,2013 09:50 File folder
B Ju infragistics
JJ 20103CLR35
| Images
. system_web
. MCweb
. Perflogs

=

. Program Files

=]

Program Files (x86)

=

. temp

=

|, Users
. Windows
FIEE g M4172.78.100. 218) (N:) El

2]

] 2 tems
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IS Configuration:
Install Infragistics:

» Go to Control Panel > Administrative Tools > IIS > click on your host name > Sites >
Default Website > right click > Add Virtual Directory

“ Internet Information Services (IIS) Manager ) o [ 3]
@ G) [@ » WIN7-64FC P Sites b DefaultWeb Site b ] & @ -
Fle View Hep
> Default Web Site Home
# | ) Explore
£ 95 WIN7-64-PC (Win7-64-PC\Win7- - = Edit Permissions. ..
53 Applcation Pools Filter: - Bce - Ghshow Al | Groupby: Arca - -
(8] Sites ASP.NET = G
-6 B » i = Brdes..
| aspnet_q 4 Explore > e\ q B
[ aspret 2 Iy () o 12 & E; [2] Basic settings...
&[] MCweb Edit Permissions. . = LEf @ e
-  F .NET Error MET .METProfile  .NETRoles  .NETTrust  .NETUsers View Applications
&) add Appiication... Iztion Pages  Globalization Levels View Virtual Directories
+  Add Virtual Directory... ‘h - -—‘= T - Manage Web Site (A
Edit Bindings # > —E ot = 2 Restart
e bction  MachineKey Pagesand  Providers  Session State  SMTP E-mail - e
Manage Web Site » [0 Controls b start
# Stop
Refresh
& Browse Web Site
K Remove !) — ‘] Browse =180 (http)
i 61
Add FTP Publishing... % é (/] 04 Advanced e
tication Authorization CGL Compression Default Directory Error Pages —————————
Rename Rules Document Browsing Configure
5 Switch to Content View 3 Py o Q = Falled Request Tracing. .
e | dg fa & J’] Limits. ..
FaledRequest  Hander  HTTPRedrect ~ HTTP IP Address  ISAPIFiters  logging  MIME Types add FTP Publishing. .
Tracing Rules  Mappings Respo...  andDom...
” £ @ e
I - o= - )
4?% ?5.;& & % = Onling Help
4 e [ Features View = Content View
Ready 9

>

2

Site name:
Path:

/

Default Web Site

Alias:

Iig_c:::mmc:n

Example: images

Physical path:

IC:‘n,ineu:rub‘n,wwwrnnt‘l,aspnet_dient‘n,infragisﬁcs
Pass-through authentication

Connect as...

Test Settings...

|

Cancel |

o Alias:
0 Physical Path:

ig_common
C:\Inetpub\wwwroot\aspnet_client\infragistics

In the following dialog define the Alias and the physical path for the files:

Add Virtual Directory I
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» Confirm with

» Now select the new folder ig_common in the tree view on the left and open the
context menu by right click:

& Internet Information Services (IIS) Manager ) o ] 4]

@_é’) [ & » WINT-64PC b Sites » DefaultWebSite » ig_common »

CEEICE

Fle View Help

Ready

# _ | ig_common Home
il | el P £ Explore
EI-¥5 WIN7-64-PC (Win7-64-PC\Win7- o = Edit Permissions. ..
(£} Appiication Pocls Filter: - Bfco - (gshow Al | Groupby: Area - 2 -
58] Sites ASPIET = [=] Basic Settings...
B Defauit Web Site = . 2 7 P Manage Virtual Directory |4/
(7] aspret_dient b= 2 e (2N q = =
7] MCweb 2 = o4 . 0% 2 [E, el Browse Virtual Directory
& NET NET NET Error NET METProfle  .NETRoles  METTrust  .NET Users Browse *:30 (http)
Bl Exlore impilation Pages  Globalization Levels
Edit Virtual Directory
Edit Permissions... ) E B = b, @ )
.dll‘ , 5 % Advanced Settings...
S Convert o Application . H i 3
sl ik | nection Machine Key  Pages and Providers ~ Session State  SMTP E-mail @ Help
(& Add Applcation... Btrings Controls Online Help
&l Add Virtual Directory. ..
Manage Virtual Directory ~ »
B3 Refresh ,g;,!; ’;% E @ ]
K Remove hentication Authorization cal Compression  Default Directory  Error Pages
Rules Document  Browsing
= Switch to Content View =
pou | i & F e Q S ;;H
% 4= 9% il = ﬂ - 4=t
FaledRequest  Handler ~ HTTPRedirect  HTTP 1P Address logging ~ MIMETypes  Modules
Tracing Rules  Mappings Respo... and Dom...
e o= l
Al | v [ElFeatures view |\7 Content View

-

» select “Convert to Application”

Add Application

Path: /

Site name: Default Web Site

Alias: Application poal:
Iig_::ornmon IDEhuItAppPool
Example: sales

Physical path:

IE:‘ﬂnetmb"lgﬂwwmot‘pspnet_dient‘ﬂnﬁagisﬁcs

Pass-through authentication

Connect as...

Test Settings...

» confirm with L&
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Create Application:
» Now select the MCweb folder in the tree view and open the context menu by right

click:
e
@6} lj » WIN7-54PC b Stes b DefadtWebSite » MCweb * Jﬁ} < @ -

Fle View Help

| J MCweb Home

&) Explore
B85 WINT-64-PC (Win7-64-FC \WinT- = = Edit Permissions. ..
: Filter: ¥ [HGo ~ \mgShow All | Groupby: Area - 55~ R
; ,;,‘b Application Podls o 5| | p by
-8 Sites ASP.NET A Manage Folder (&)
£ Default Web Site . - . P Browse Folder
| aspnet_dient = b3 i LN q = =
: i \\2 0 [O= ) IE) [, Browse *:80 (hitp)
= NET NET \NET Error NET MNETProfle  .NETRoles  .METTrust  .NET Users @ rep
mpilation Pages Globalization Levels =
£ Explore Online Help
Edit Permissions. .. . i% B L& )
o) L =B &3) K]
! Convert to Application nnection  Machine Key  Pages and Providers ~ Session State  SMTP E-mail
Adc Application. . trings Controls
Add Virtual Directory. ..
Manage Folder » .
e | E ca1 'y
& Refresh ﬁz) ) @ G E i
entication Authorization cGl Compression  Default Directory  Error Pages
i Switch to Content View r Rules Document Browsing
i: wly ey, N =) B »
gj dg = i'g J'Jn 4=t
FaledRequest Handler ~ HTTPRedrect ~ HTTP 1P Address logging  MIMETypes  Modules
TracngRules  Mappings Respo...  andDom...

¥ ¥ 8 @ s

" | 5 Elsever] - o

Ready %

» Select “Convert to Application”

Site name:  Default Web Site
Path: /

Alias: Application poal:
[MCweb |pefaultappPocl Select...
Example: sales

Physical path:
IE:‘lﬂnetpub‘lfﬂwwrthCweb e |
Pass-through authentication

Connect as... Test Settings. ..

» Confirm with L

» Next step it is recommended to execute IISRESET or restart the IIS via the
application:
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& Internet Information Services (IIS) Manager

=loi=]

@-@ [‘5 b DE-NABI0-113 #

File  View Help
[eomections
| Q;, DE-N-NB10-113 Home
] Manage Server
R0 o013 Filter: - Bfce - Ghshowal |Grouby: Area & R
P Start
ASP.NET -
I B Stop
;5& \&2\ ’0 é Eﬁl‘ View Application Pooks
NET NET NET Error NET NETTrust  Application  Connection WEnEEE
Authorizati... Compilation Pages Globalization Levels Settings Strings Change .NET Framework Version
E = | -+ 1 @ tep
ilj @?) &} @I Orline Help
Machine Key ~ Pages and Providers ~ Session State  SMTP E-mai
Controls
s
Authentication Compression Default Directory Error Pages Handler HTTP
Document Brawsing Mappings Respa... =
E“ % g ) " R =
e’ s P =
1SAPT and CGIL  ISAFI Filters Logging MIME Types Modules Output Request
Restrictions Caching Filtering
Ll &;;}g =l
[=]Features View |/ % Content View
Ready 9.
In the ideal constellation the MCweb service is already operational now.
For the first test mark the MCweb service and select “Browse” in the left panel menu:
JS=TET

@@ [? b WIN7-64PC b Sites » Defsult Web Site » MCweb »

RIS

Fie View Help
Ll
=93 WINT-64-PC (Win7-64-RC\Win7-
- [2¥ application Poals
Sites
E-€D Default Web Site

] aspnet_dient

4| | »

Ready

&) /MCweb Home
B

Filter:

~ ffico - isshow Al |Groupby: Area

ASP.NET

NI
Authorizati...

Application
Settings

s

=
ASP

&

Failed Request
Tracing Rules

e

& &
& L 4
NET NET Error NET
Compilation Pages Globalization
3 Bl ,
|ab) [
Comnection  MachineKey  Pagesand
Strings Controls
E& 555 CGI
Authentication  Authorization CGI
ules
= B
£ dg
Handler HTTP Redirect HTTP
Mappings Respa...
= )
o= b
ominab  OO1 Cobbimon  iftcknal

=

JNET Profile

NET Roles
-
' &
|
Providers Session State

g

o

Compression Default
Document
F L J%
o =
1P Address Logging
and Dom...

BV
NET Trust
Levels

SMTP E-mail

Directory
Browsing

=

MIME Types

)

NET Users

Error Pages

<=l

Modules

20 Explore

Edit Permissions. ..

Basic Settings...

Wiew Virtual Directories

Manage Application a

Browse Application
Browse %80 {http)

E Features View |i7= Content View

Advanced Settings...

@ Help

Online Help

&

The system will now open a browser and try to start the application:




2 Login - Windows Internet Explorer

MICros’

Materials Control

Close
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Report Logo:

Please ensure that the correct report logo is in place.
The logo can be found at:

\Inetpub\wwwroot\MCweb\Common\Rst

N
Gk)v‘ .~ Computer ~ System (C:) - Inetpub ~ wwwroot ~ MCweb - Common ~ Rst ~

v &) [ searchrst

Organize ¥ (Z30pen ~ Print Burn  New folder
‘¢ Favorites _l Name = Date modified Type | Size |
B Desktop || IssueRequest.rst 16.08.2011 13:51 RST File 29KB
& Downloads || IssueRequestHeader.rst 26.08.2010 09:36 RST File 38 KB
ecent Places |_| IssueRequestHeaderNoPrice.rst 26.08.2010 09:36 RST File 33KB
. Termine || 1ssueRequesthioPrice. rst 26.08.2010 09:36 RSTFile 33KB
|| IssueRequestTaxSummary.rst 27.10.2010 15:35 RST File 43 KB
w7l Libraries M. ’ ,
3 Documents (=] itemsWMS. flat. template 30.10.2007 15:07 Delegate ExportImp... 1KB _I
ivcack.usfood. edi. template 12.05.2011 14:27 Delegate ExportImp... 1KB
Music
(=] Pictures
El] Subversion |_| ManageStare. rst 16.08.2011 13:51 RST File 35KB
B videos || ManageStoreMultipleCC.rst 10.11.2012 13:16 RST File 39KB
|_| MasterDatalmport.rst 25.09.2011 10:08 RST File 13KB
#dy Homegroup
menuplanexport, template 30.10.2007 15:07 Delegate ExportImp. .. 5KB
Computer || MenuPlanLabelPrint.rst 21.01,2010 06:42 RST File 8KB
&, system (C) || MenuplanProfitAndLossSummary.rst 30.03.2009 13:57 RST File 82KB
3 Data 0:) | LIMenuplanProfitAndLossSummaryMyGuest.rst  12.04.2010 15:37 RST File 109 KB =l
logo.GIF Date created: 15.04.2013 17:43
- o GIF image
mlcros Date modified: 13.08.2012 15:43
Materials Control Dimensions: 357 % 90
Size: 5,21KB

C:\Inetpub\wwwroot\MCweb\Common\Rst\logo.gif

This logo is part of the standard install set for MCweb, but you can also replace this logo
with the customer’s logo.
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Recipe Pictures:

To display Recipe Pictures in MCweb some configurations needs to be done. Please see
below all necessary settings.

The ideal Picture size to avoid stretching is 320 x 200 Pixel

Picture Storage:

A dedicated Picture Folder on your Web Server needs to created, i.e. “Recipelmages”.
The Folder can be situated anywhere on the network, we strongly suggest to keep
everything on the same place i.e. C:\Inetpub\wwwroot\Recipelmages\ on the web server!

B C\inetpub\wwwroot 8 =[Ol =]
‘@( )v | . = Computer - Local Disk (C:) - inetpub ~ wwwroot - - ‘al Search wwwroot [:]1
Organize ¥ 5 Open Indudeinlibrary v  Sharewith »  Mew folder S ERHS 2 E:l I@l

i RecentPlaces 4| pame - Date modified | Type | Size | |
. : 2 J aspnet_client 16,04, 2013 10:06 File folder
=l Libraries

3 Documents | MCweb 15.04. 2013 10:59 File folder

J‘. Music . Recipelmages 17.04.2013 17:27 File folder

&= Pictures aiissmrt.hh'n 12.04.2013 10:55 HTML Document 1KB

B videos ] welcome.png 12.04.2013 10:55 PNG image 181KB
1M Computer

&, Local Disk (C:) |

RecipeImages Date modified: 17.04.2013 17:27
J File folder

» Inside this folder another folder is required. This folder must be named exactly the
same as the Oracle User in the web.config. Here in this example in the web.comfig
the user FBO80O0 is used and the folder is named in the same way:

g =10l |
- @I I Search Recipelmages [.‘]‘
Organize ¥ - Open Indudeinlbrary =  Sharewith v  Mew folder = E:l '@'
¢ Favorites Mame Date modified I Type I Size | |
B Feoso0 18.04.2013 11:35 File: folder
- Libraries
1M Computer

£L, Local Disk (c2)
G5 e (1\172,28, 100,218

Qj Netwark

FBOB0O0 Date modified: 18.04.2013 11:35
{ File folder

The application will always search in the {Oracle User}-named folder for the pictures.
This allows the use of the same picture storage for different web service instances
without sharing the pictures.

» Now copy all pictures into the {Oracle User}-named folder. The picture fiels also
could be stored in separated subfolder (e.g. by category):
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inetpub\wwwroot\RecipeImages\FBOB00\Beer

[

—
Qv | . = inetpub - wwwroot ~ Redpelmages ~ FBO300 - Beer -

)

I Search Beer

Organize -
- Favorites

B[ Libraries
@ Documents
J’ Music
[E5] Pictures
E Videos

1% Computer

Gh Network

12 iterms

Include in library -

Share with

1A
s
‘9

Erdinger

Gaffel_Koelsch_50l
_Keg.jpa

Slide show

gaffel_fass.jpg

Gaffel_Koelsch_50l
_Keq_-high.jpg

Mew folder

Gaffel_flasche.jpg

o
[

Baffel Rolsch

Gaffel_Koelsch_Kas
ten_20x05]_Seite_
Frontseite-M.jpg

s
- =

i
9 Guoffel fals?

Gaffel_Koelsch_301 Gaffel_Koelsch_033
_Keg_-+M.jpg |_Flasche-M.jpg

IT_Gaffel_Koelsch_ Thumbs.db

301_Keg_-M.jpg

[IS Configuration:

» Please open IIS Manager (Start > Settings > Control Panel > Administrative Tools >
Internet Information Services.

Select Sites > Default Web Site > right click to open the context menu > Add Virtual

& Internet Information Services (II5) Manager -0l x|
6;3 [ %5 wnzsapc » |G i 1@ -
Fie View Hep
@) WIN7-64-PC Home
| y Manage Server
-85 WIN7-64PC (Win7-54PC\Adnmir = 2 Restart
2 Appicaton Pocis Fiter: - fico - GHshow Al |Groupby: Area R "
B[] Sites ASP.NET 4]
- ® soo
aspnet_L Explore > 0 2";{ :I:' i;? View Application Pools
ig_comm Edit Permissions. .. . = ' . View Sites
MCweb ET NET Error NET NETTrust  Application  Connection  Machine Key
Recpel] () Add Applicaton... lation Pages  Globalization  Levels Settings Strings Change NETFramevir il
.| Add virtual Directory... k2 g @ rebp
B Oniine Hel
== p
Lkt iders  Session State  SMTP E-mail
Manage Web Site »
2 Refresh
Remove " - —
) : € 1 & %
Add FTF Publishing... FT7) ) i)
P FTPDirectory FTPFirewal ~ FTPIPv4  FTPLlogging FTP Messages FIP Request
Rename wizati...  Browsing Support  Addressa... Filtering
[ Switch to Content View 2
FTP i G
FTPSsL FTP User
Settings Isolation
s -l
4 | v| [E]Features View | - Content View

Ready

-
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2/ x|

Site name:  Default Web Site
Path: /

Alias:
Ipidures

Example: images

Physical path:

IC:‘n,ineu:ub‘n,wwwmnt\,ﬁ'.edpelmages _I
Pass-through authentication

Connect as... Test Settings...

Cancel

» Here define the Alias as e.g. “pictures” and the physical path pointing to the
previously created directory.

» Confirm with .

» Select the now displayed virtual directory in the IIS Manager and open the context
menu by right click:

& Internet Information Services (IIS) Manager

@é‘) [!_j » WINZ-64PC » Sites » DefaultWebSite » pictres »

Fle View Help

F | pictures Home Adons

(=]
| &l < 25 1@ -

! Explore
(-85 WINT-64-PC (Win7-64-PC\Admir " - = Edit Permissions...
53 Application Fodls Fitter: - Bfico - Gshow Al | Groupby: Arca - [E- e
5 sites F— = [ Basic settings...
=@ Df'““ Web Site e . ot P Manage Virtual Directory (A
[ aspnet_dient = . [+ S 2N e 4
¥ % N 404 : S5 2 I=f E Browse Virtual Directory
NET NET NET Error NET NETProfle  .METRoles  .NETTrust  .NET Users Browse *:80 (htp)
Authorizati...  Compiation Pages  Globalization Levels -
= Edit Virtual Directory
cures . - b -
J E Advanced Settings...
Bl evioe @ W G ad et et
Edit Permissions. .. lnection  Machine Key ~ Pagesand  Providers  Session State  SMTP E-mail @ Hep
ing: Controls
c e At Online Help

=

5,

£ Add Application...

.| Add virtual Directory...

Manage Virtual Directory  » ﬁ&) "% \% [/] =0

hentication Authorization Compression  Default Directory  Error Pages

K3 Refresh Rules Document Browsing
K Remove E o
e ] iy, L g S '!;DH
[7Z switch to Content View - 14e] L ° 7 =il
ramerREqUEST—tandler  HTTR Redrect PAddress  logging  MIMETypes  Modules

TracngRules  Mappings and Dom...

*® 23 % «B

= E 8
! | »f Ereusven]conmtven

Ready

.

» Select “Convert to Application”



Add Application

Site name:
Path: /

Default Web Site

Alias:

Application pool:

pictures.
Example: sales

Physical path:

IDEquItApmeI

IE:‘lﬂnEmJb‘lgﬂwwmot‘Redpelmages
Pass-through authentication

Connect as...

Test Settings...

> Confirm with

»

In the IIS Manager tree view the web application “pictures” is shown.

"k Internet Information Services (I15) Manager

6@ [\? » WIN7-64-PC P Sites b DefaultWebSite b pictures »

File

2|
E

4

View  Help

5 WINT-64-PC (Win7-64-PC\Admir

L2} Application Pools

(&) Sites

=€ Default Web Site
[ aspnet_dient
P ig_common
MCweb

| Recipelmages

&3 /pictures Home
&

Filter: - Bico - Ghshow Al | Groupby: Area
ASP.NET -
= & o q Pey
5 ¢ ° & 8 a2
NET NET .NET Error .NET NETProfle ~ .NETRoles  .NETTrust  .NET Users
Authorizati... Compilation Pages Globalization Levels
w & & L=
lab] B = | =
Application  Connection  MachineKey  Pages and Providers  Session State  SMTP E-mail
Settings Strings Controls
s
0= : e \% L]
ASP Authentication  Authorization CGI Compression Default Directory Error Pages
Rules Document Browsing
= & b a ¥ Q S H
% = He i'g-i ﬁ— 4=l
Failed Request  Handler  HTTP Redirect 1P Address Logging MIME Types  Modules
Tracing Rules  Mappings Respa... and Dom...
3 = ")
?f = o= Nowv)

Ready

| = |Features View |/ = Content View

=10l x|
EREITE
acens
2 Explore
Edit Permissions. ..
[E Basic settings. .
View Virtual Directories
Manage Application (~)

Browse Application
Browse =:80 (http)

Advanced Settings...

@ Help

Oriine Help

&
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Web.config Adjustments:

» Please open the Web.config file at your MCweb Installation Folder. This file can be
found at i.e. C:\Inetpub\wwwroot\MCweb\Web.config

An additional line needs to be entered, please add to the appsettings part following line

. C:\inetpub\wwwroot\MCweb N =10l =|
‘G(Jv ‘ . = Computer - Local Disk (C:) ~ inetpub = wwwroot = MCweb ~ - @I Search MCweb m
Organize ¥ | Open New folder g= = i @'

- = - -
¢ Favorites Name Date modified Type | Size I_l
| LDAPLogin.aspx 06.06.2012 13:15 ASPYX File 10KB
u—Q_Uh"a”ES a Loading. html 30,10.2007 15:07 HTML Document 2KB
f Poamens =] Login_GERMAN xml 09.10.2008 14:16 ¥ML Document 2KB
" Music
|| PortalLogin.aspx 12.09.2011 16:19 ASPY File 2KB
(=] Pictures
Readme. txt 16.04.2007 14:37 Text Document 2KB
B videos -
| wersion 12,04.2013 1426 File 1KB
18 Computer || web - Copy.config 16.04.2013 10:38 COMFIG File 16 KB
£, Local Disk (€2) =l w 16.04.2013 11:04 CONFIG File =
web.config Date modified: 16.04.2013 11:04 Date created: 156.04.2013 10:07
CONFIG File Size: 15,1KB

» Create a backup copy of this file first.
» Open the file with an editor.
» Search for the following key (add if not existing).

<add key="ImagePathlIS" value="../Pictures"/>

:.weh.conﬁg - Notepad = IEIIﬂ
Fle Edit Format View Help
</configsections> ;[
<infragistics.web imagebirectory="~/../ig_common/images"
javascriptDirectory="~/../ig_common/20103CLR35/s5cripts” />
<appsettings>
<add key="ExpirationPage” value="Common/forms/SessionExpired.htm" /> J
<add key="PathToRoot" value="../.." />

<!-- see help 3) -—>
<add key="Lograth" value="c:/temp" />

<!-- Place to store error logs -->
<add key="ImagePath" value="Common/Images" />
<!-- Normal images of MCweb -->

<add key="appImagerath” value="Common/AppImages” />
L Images heeded for the menus-->
A2 Key= ImagePathIIS value= . J
<l'-- Images stored by plication -->
<add key="DocumentPathII5" value="../Documents" />
<!-- Documents stored by the user via the application -—=
<add keﬁ:"serw‘cepath" value="¢C:/service” />
Scheduler working directory-->
<add key="useLoadingBar" value="true"
<!-- "true" / "false" //replace the please wait msg into the new one (in style of the mCweb
menubar) —->
<add key="Filteralign" value="left" />
<!-- experimental key if filter buttons refresh & sort are left or right aligned--> =l

0 Make sure that the term “Pictures” is defined as the used alias from the
virtual directory

o The “../” indicates the Folder Structure please ensure that you use the correct

amount of “../” if you place the Recipelmages folder anywhere else than
explained in here.

» In Thick Client define the same dedicated Recipelmages Folder at
System > Configurations > Path > PICTURESTORAGE > Value:
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|-: Configuration Settings 10 x|
File Edit System netSel Help

ERC 4l

e | Customreparts ;I lame | Yalue | Infarm
(1 Einkaufausw FORMULARE Path fi
x| Ergebnis .PICTURESTORAGE CiAInetpubiwwroot\Recipelmages Path fi
B8 Fex Horeries QRP_ENG Path i
[ D Fibu @l RPTFILES RPT_EMG Path i
w0 Ifeh2h Option: Change Configuration Settings ) x|
&1 International
-0 Inwentur Configurations File [fbvE.ini
= Kassen Section [FATH
& Lager

: Item JFICTURESTORAGE
-0 Mail I
&3 Menuplan Walue |C:Inetpubvivwroot\Recipelmages
w21 Mames Information [Bath for Pictures for Recipes [please note that this directan must be
i a stared on the webserver if MCweb iz used)
{1 Produkt
&0 Rechnung
{1 Recipecomponenttyr
- Rezeptur
{10 Shipment i Caittid |
{10 System
[ T Teamedar ;“ 4 I I _pl

| jm [

0 Here the network share name for this folder must be used.
(the recipe storage on the web server must be shared, since otherwise the
thick client users will not be able to access this folder!)

» Please assigning now the pictures to recipes as explained in the related
documentation. In MCweb these pictures will now appear in the application:

» Recipes > tab Details:

/2 Recipe Detail - Windows Intermet Explorer P I=TES|

@‘:’“-[5 17258 100, ZMmceeeb 700 ProductoniboptaRecptOttal as jdea =il % P Bl

Lo Pavories  Saecpe Detal | |

= Overvew = liew = Seve ® Gavens = Gwve wndBack = Dwelzfeccs = Pl e Uenleny = Aeout |

Fre ) [ ¥ Corporate Recoe
Recipe Sandwich P& Coks Wiz i [ hacte Recpe
Fecioe o eS8 .
/2 Recipe Detal - Windows Internet Explorer =10 =}
g-\_.-ts o/ 172, 28, 300. 218, rodaction Biecpes Eiecosletsl s HOW = 1kst_id e ) L=
Incyecerts | Dstads | Preducton | Catsgedes
L Fevortes [ Recoe Detat | |
Becipe Group  Sasdwiches =]
Major Group  Food FOS * Dvervew ® lew ® Bave % Savens # SaveadBack # Deiele Recpe # Pend ¢ Useeny @ Aboud |
v | ) ] 7 Coprne e
Portion Siee 1.200][F
" Recpe Sandwich P L Cokn 1 i [ acivn Aece
Bumber of Porsons 1,500] Weigh
Recoe No. Tus13 Cost caioulated for Castoenter lan Siore Severage

13300003 Brot, Toast kg
18100001  Bulter KO Name i Becu
12100002 Tematoss ky

-»
&
1
i 14300000 Cheess Gouda
5
&
&
o)

10200001 Salami KG
16900001  Mushrooms [ C
17000004 Katchup Herg

E Albeer FL (360 ot Seacication

tig, Coca Cola 0.2 FL (33013 ( Coca-Col 0,24 ) . Musheooms / Can 220¢r, Cheese Cruda, Ketzhes Henz

[ Hew ngresent Ectngresent. | [Delet [50m. Tomattes kg, Salami K. Bulter KG

Serving nstructions

j FOODSCHNKLN_SANDWICH 976G
[chengs | Cow ][ Dedwis ]
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» Recipes > Print

/2 Bevipe Deled - Windows Intormel Explorer

Preview:

O -G

Favortes

172,28, 500,238

[ Rucpe Detal

=14 % PR -

Frev [ ]
i Sandwich B & Cabe
Rmce e s

Ingemcderts | Detats | Procuction || Categories

Récit Group Sandwiches
Major Group Feos WIS

1.000

T Humber
10003

Ingredient

Pos

Bect, Toast kg

¥ Comerate Aecipe

1 T macive Recee

Cal Het Waigat
Cale. Wagh Bert

Preducsn Lass

Fortian iz =
Humber of Portions ieight Pt 011 Kiogran
Fnd_Anice.

POT GTY Std. Port.
0,687 kg

&
Ldb 10100001 Dester KG 11,654 grams
B 12100007  Tomatoes kg 0,633 kg
| db 14300001 Cheese Gouda I 0,622 kg
b 10200001 Sslar NG | 0,018 kg
16500001 Mushrooms / Can 230gr | 0,027 En
& 17000004 Ketchup Heing 350ml | 3,600 mi
[ ciss Blttier FL (360021 1,000 1,000 £
4]
[t igragace | [ | Chaergance Pon | [_scam Rat

Document Attachm

==Y - overvew w tiew » Gaee v Saveas w Savesnalack » Dsktefecee » P w Man e ® Abos |

Sandwich IP & Coke
et gt Paroay 5. Pres os% viay
T
‘egniPeron Partion actsr it o
#roa Loas Pt S cos s
<

FPos| Type |Number | ingredient POT QTY|5td. Port. Weight Loss|  ACT QTY|0U )
1 b 13300003 Beet, Teasthy 0087 kg 50873 0,00% 0,0872 Kilegram 3,000
2 b 10100004 Duster G 14,000 grams G010 5,00% 0,014 Kilogram 0,750
3 & 17100007 Temsboes kg 0,033 kg o037 000% 0,0337 Kilagram 3,000
4 b 14300001  Cheese Gouds G022 kg G021 0,80% 0,6218 Kilogram 0,75
S B 10200001 Salami KG 0,011 kg 80009 0,010 Kilogram 0,890
& 0 16500000  Mushrooms / Can Z3dgr 0,087 Ea ,0060 0,0273 Each LE0]
7 b 17000004 Ketchus Heing 350ml 3,000 mi B,0030 0,0030 Liter 6,571
8 9 Al FL (38003 1,600 1,000 En £,3300 1,0000 Each 0,358

A1 |

Hulricnts Parl. 1005 | Unit
FRORUEHOR Iikirnotions: Food enerdy 44,73 364,11 kea
Product Specification: Protan 15,72 1333 g

ents:

Since MC Version 8.6.6.30.x the application also supports document attachments for
Purchase Orders and Order Requests. Please see the detailed description of this feature
in the separate manual “136_MC_PO _internal_Attachments”.

How to Speed up your ASP.NET application

By switching off tracing we can speed up the application.
Please change enabled="true" to enabled="false" in web.config files at following folders.

- C:\Inetpub\wwwroot\MCweb\ web.config

Below you find an extract of the web.config file.

<l-- APPLICATION-LEVEL TRACE LOGGING

Application-level tracing enables trace log output for every page within an
application.
Set trace enabled="true" to enable application trace logging. If
pageOutput="true",
The trace information will be displayed at the bottom of each page.
Otherwise, you can view the application trace log by browsing the "trace.axd"
page from your web application root.

-—->
<trace
enabled="false"
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requestLimit="10"
pageOutput="false"
traceMode="SortByTime"
localOnly="true"
/>

If you want to see what is usually collected during trace, open file
C:\Inetpub\wwwroot\MCwebV3\trace.axd

How to extend the Internet Explorer Session Timeout

By default Microsoft Internet Explorer will close your MCweb Session after 20 minutes, if
you haven’t clicked on any function at MCweb.

At Timeout you will receive a message like “...session has expired”.
To extend the timeout please change following at C:\Inetpub\wwwroot\MCweb\web.config

You can change the timeout in minutes, i.e. as shown below to 60 minutes.

I =10l x|

% web.config - Notepad |
File Edit Format Yiew Help
=

-
<sessionstate
mode="InProc”
stateconnectionstring="tcpip=127.0,0.1:42424"
sq1cgnnecti9nstriqg= data source=127.0.0.1; Trusted_Connection=yes"

ot Tse’ o
| _>I_I
A

| Lnoa, colze
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Troubleshooting:

This section will describe some problems which can occur in certain environments.

Error Log File:

In case of any error the support teams will always need the current log file. This can be
found on the c:\ drive in the defined TEMP folder.:

lC:\temp N 10 x|
‘Qev | . = Computer - Local Disk (C:) ~ temp ~ - ‘a I Search temp [ﬂ‘
Organize * ||Open ~+  New folder = ~ O @
) Install ﬂ Name « Date modified | Type I Size | I
| PerfLogs
4 Jdg_1 25.01.2013 10:06 File folder
. Program Files
| Program Files (x 4] 20130416, err 15.04.2013 15:50 ERR File 346 KB

Bl 20130417,

. ProgramData

4. Recovery
3. System Volume I
. temp
. Users
| Windows |
20130417.err Date modified: 17.04.2013 15:00
) ERR. File Size: 110 KB

17.04.2013 16:00 ERR File

Date created: 17.04.2013 03:45

The application creates one .err file per day, e.g. 20130417 .err for the error log for April

17" 2013.

Error on first time choosing ORDERING I:

Please ensure that Internet Information Services (11S) was installed first followed by

Microsoft .NET Framework.

If Microsoft .NET Framework was installed 1°:
If the .NET Framework was installed before the IIS, you need to register ASP.NET.
Execute %windir%\Microsoft. NET\Framework\v2.0.50727\aspnet_regiis -i from the

command line.

Error on first time choosing ORDERING II:

Once you are logged into the system click on Ordering to see if the Database connection
is available. If you run into error “unable to find/open oci.dll” the ASPNET-User has no

Administrative Rights.

If the error still occurs, make sure the oci.dll exist in c:\oracle\Ora<Version>\bin or

wherever your Oracle was installed.
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Open Orders not shown in Receiving:

This occurs because of a bug in Oracle Patch 9.2.0.4

In this case please upgrade your Oracle Server and Client to Oracle 10g or 11g.

Pages not refreshing:

If your pages are not refreshing, after you changed certain information please check that
the following setting in your Internet Explorer > General > temporary Internet files >

settings is set to NEVER.

settings 2 x|

i Check Far newer versions of stared pages:
I ™ Every visit to the page
o Evwery time wou skark Internet Explorer
{* Aukomatically
™ Newer

 Temporary Inkernet files Folder

Current location:  C\Documents and Sektings)Daniel
SchaeferiLocal Settings! Temporary
Internet Files!,

Arnount of disk space ko use:

)' [ e

Mowe Folder. ., | ‘Wiewa Files, ., | Wiews Cbjects, |

o4 I Zancel |

Oracle 10g settings

Resolution:

Oracle 10g uses dynamic transparent network substrate (TNS) registration, which causes

problems when using templates.

To get around the ORA-12528 error, add a reference to the database in the listener.ora

file...

Common language for mortals:

What needs to be done on server where Oracle is installed — example for this

instance:

LISTENER.ORA
# listener.ora Network Configuration File:

C:\oracle\product\10.1.0\db_1\network\admin\listener.ora

# Generated by Oracle configuration tools.
SID_LIST_LISTENER =
(SID_LIST =
(SID_DESC =
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(SID_NAME = PLSEXxtProc)
(ORACLE_HOME = C:\oracle\product\10.1.0\db_1)
(PROGRAM = extproc)

)

(SID_DESC =
(SID_NAME = testoral)
(GLOBAL_DBNAME = testoral)
(ORACLE_HOME = C:\oracle\product\10.1.0\db_1)
(SID = testoral)

)

)

Once Lines in red have been added, restart listener service, than Oracle service.
After that, connections from MCweb are possible.

Connection Error

Especially when working in 64bit environments and having the thick client and the
MCweb server installed on the same machine, it very much depends on the sequence of
the single installations.

In general the following is recommended:

Operating System
NET Frameworks
Internet Information Services
Oracle Client 64bit
Oracle Client 32bit

YVVYY

In certain cases the application may not be able to find the proper Oracle Home, even
though this is defined in the environment variables.

5 Login - Windows Internet Explorer m — o x|
—,
@\;—7 - [ hitp:/locahostimonel O] | B[+ X [Z Loain x ok
5 [@Htogn
El
Materials Control
User
An error occurred during login - please contact an administrator
Close
H100% - 4

The .err log file will show the following entry:
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Fie Edt Format View Heg

System. web. Wttpapp]ication. Executestep(IExecutionstep step. Booleand cwletedsmhromslyj IL=1b NAT=ab =]
system. web. wrrpapplicationsapplicarionstepmanager. kesumesteps (Exceprion error) IL=109 MaT=1a5

System, web, HEEpAPR]icat fon, System. web. THEEpASyncHand ler . BeginfrocessRequest (HEpCont ext mnl ext, asyncCallback cb, Object extrabata) ILeSc MATwd3

System. web. HEEpRUNT ime. Proc Internal (HEtpWorkerRequest wrg IL=fc NAT=1c4

System. wel RUNTme. ProcesskequesTNoDenand (HETpWorkerRequUesT wr) ILe=26 NAT=7c

System. web. MoSE ing, TSAPTRUNT ime. Pro sfequest (IntPtr ech, Intd? iwWRType) TLedb MAT=18c

geFormatexception

This prablem will occur

Exceprion stack:
Eystem. Data. l‘ro\.-ir;h.rn.l'.z Dbcmmzx_timml cu.\.c«mex.tiw(obcum-utinn  owmingObject) IL=122 NAT=242
dib : 2:3 : System. InvalidOoperationException: ATTempt TO|w-ider
running in 64 bit mode with the 32 bit oracle client components
caused by System.Data.oracleClient
Exception Stack: ing, pecinals
m.Data.Providergase. bbconnectionPool. GetConnection{DbConnection|erorite) wass

Mle?a(esys patasccess.userprofile, . ctor(ConnectionParams connectionParams, Int32 bst_id, String prf_name, String app_Dir, Soolean generaterrofile) ILeas

D€l egatesys. Datasccess. usererofile. . ctor (ConnectionParams connectionParams, Int32 bst 16. string prf_name, string app.oir) IL=0 NaT=79
ue1ega(esys myInveLory., FormLogin. Loginclick(object sender, EVenTArgs e) IL=796 NAT=
wmplete stac
systeu.\nh.I!:.Hebcamrols.lutton.onc]itk(!uemd\rgs @) IL=19 NAT=73
SysTem. web. Ul webControls, BUTTON, Ra1SePosTBACkEVENT(STring eventargument) IL=31 MAT=8C
System. web e, RaisePostBackivent [ TPostBackiventHandler sourceControl, String eventirgument) TLe0 NATs1d
System. web. UT. Page. ProcessRequestMainBoolean includestagesBeforeasyncPoint, Boolean 1m1ude5ugesnfler&smwo‘im) IL=5¢2 hn\'r-bab
SysTem. web. UL, FAge. ProcessRequest Eam ean 1ncludestagesseforeasyncroint, soolean includestagesafrerasyncroint) IL=3c NaT=

System. web e, ProcessRequest () TLelc NATwSh

System. web. UI. Page. ProcessRequest (HTTpContext context) IL=-31 MAT=FO

ase. formlogin_aspx, Proc HTTPCONTEXT COMTEXT) IL=0 NAT=G

System. web, HEEpApp]icat iomCal THand Ter g xecut ionStep. System, b, MErpapplication, IExecut ionStep, Execute() TuLs=124 NAT=257

System.web. Httpapp]ication. Executestep(IExecutionStep step. Booleand cwletedsyn:hronwsly) IL=1b NAT=ak

system. web. wrrpapplicationsapplicarionstepmanager. kesumesteps (Exceprion error) IL=109 MaT=1a5

System, web, HEEpAPR]icat fon, System. web. THEEpASyncHand ler . BeginfrocessRequest (HEEpCont ext ont ext, asyncCallback cb, Object extrabata) ILeSc MAT=d3

System.web. HEEpRUNT ime. ProcessRequestInternal (HETpworkerRequest wr) IL=fC NAT=1cd o

In this situation the used application pool could be changed to allow 32bit applications.

" Internet Information Services (IIS) Manager (3l x|

@@ [ 2 v winzsepc v appication Pools & < @ -

ol R - cci sciiings 2
. Acdons
qi! Application (@ (eneral = & add Appication Pool...
Sl i set Application Pool Defaults. .
processes, contain one or mo Managed Pipeline Mode Application Pool Tasks
Filter: s Start
Queue Length L A
Start Automatically True E—
2 cPu Recyde...
L2 DefaultappPool Sta Pr ¥ Bt App T
Limit Action NoAction Basic Settings. ..
Limit Interval {minutes) 5 s
Processor Affinity Enabled False -
Processor Affinity Mask 4294867295
= Process Model Rename
Tdentity ApplicationPoolIdentity X e
Tdle Time-out (minutes) n
Load User Profie True View Applications
Maximum Worker Processes i @ rep
Ping Enabled True Orline Help
Ping Maximum Response Time (seconc 90
Ping Period (seconds) 30
Shutdown Time Limit (seconds) a0
tarh in Time Limit (saconds) an =
Enable 32-Bit Applications
[enable325itAppONWinG4] IF set to true for an application pool on a 64-bit operating
system, the worker process(es) serving the application pool will be in WOWs4
{Windows on Windows&4) mode. Processes in WOWE4 mode are 32-bit processes...
J - o | e |

Ready 9
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Domain User Support

Since version 8.7.30.xx the application allows to use the Windows Domain User to login
into Materials Control. Using this feature Domain Users known to Materials Control /
MCweb do not need to enter the user name and the password anymore.

In order to use this function the following must be configured:

FMLOGIN.INI:

Open the FMLOGIN configuration file and select the section for the database to be
configured.

i

File Edit Format View Help
[Datenbank] |

DBl=mcdata,Materials Control
DB2=mcltrain,DEMO Materials Control

Default=fhdata

[DEFAULTS]
Theme=5

[mcdatal

DBELogin=mcdata/mcdata/mcdata,Materials Control,fbmenue.ini
App1INI=fbV8.1ini

m?OOOIOO
LDAP=T

[mctrain]
DBLogin=mctrain/mctrain/mctrain,DEMO Materials Control,fbmenue.ini

AppTINI=fbv8.1ini

ki

[MCDATA]
DBLogin= MCDATA/ MCDATA/MCDATA,Materials Control,fomenue.ini

ApplINI=fbv8.ini
Licence=7000100
LDAP=T

The new entry “LDAP=T" must be added. Once done please save and close the file. Now
restart the application.
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User Configuration:
Open the FMLOGIN configuration

Go to System > Users:

@Managa Users = @ 2

File Edit System Help

N EHEREE R R R AR A 4t

Login Name Ative
User | Rights | Item Group Assignment | Recipe Group dssignment | Authonization Settings | Overview | Transfer Cost Center Security 4 b

D efault View Filker
[T Department

[ &

User
Password
Department
Phare

Fax

E -t ail

D omain&ccount Name

Language [nglish =

Infarmation Lagin Security

Here now a new field is visible. For each user the domain account name should be
defined.

Example:

@Managauaers = B ER

File Edit System Help

D=EE &k E |2 s it
Login Mame |[admin Active

User | Rights | Item Group Assignment | Recipe Group Assignment | Authonization Setiings | Overview | Transfer Cost Center Security 4 b

D efault Wiew Filker
Department

User |Systemddministrator

P d
Al
Department |Systems Management
Phone
Fax
E-tdail

Domain\account Mame | DE-N-NB10-11 3\rommeschlasger
Language English -

The application user “admin” is assigned to the domain user “DE-N-NB10-
113\jtrommeschlaeger”.
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Using the Thick Client:

When starting the Materials Control the application looks if the current Windows user can
be found in the MC user table.

If this exists ...

FBOLAT 730 MC

MICros

Materials Control

Uzer DE-M-ME10-11 3\jtrommeschlasger

s

Pazzword

oK LCancel

... the user does not have to enter the user name or the password anymore. He may
select a different database using the Options button, otherwise he can just click OK to

login.

Materials Control - Program Manager {8.7.30.39,1457 [ 14.57)
Login  Purchase Store Production Menuplan SOP  Result MasterData Reports  System

3 Login ALogot | & Reresh 7 About

Spstemadministiabor [DE-N-NE10-113%trommeschlaeger] / FBOLAT 730 MC

Menu | Search

Favorites

Eg Purchase Orders

S¥E
(,;"_’“‘ Bid Management

In Materials Control now at the top right corner both, the application user as well as the
Windows user, are shown.

For all Windows users not assigned to a Materials Control user the behaviour will be the
same as without using this function. User name and password must be entered.
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Using the MCweb Client:

This feature also could be used with MCweb.

Pre-requisites:

» Client Computers and Web server must reside in the same domain.
Otherwise the current domain user will be unknown to the web server.

» Clients must have a direct connection to the server (no proxy in between)
» Intranet only
Technically, LDAP authentication via NTLM is possible over an Internet connection, but
strongly advised against due to security and general feasibility concerns.
Overview:

To enable Active Directory (LDAP) authentication in MCweb, following steps have to be
performed:

1. Enable Windows Authentication in IIS
2. Adjust the Web.config (use supplied default Web.config in install package)

3. Configure mappings from the Domain user to the MCweb user (in Materials
Control / User Management)

4. Distribute links / train users to open the LDAP Login page
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ENABLING WINDOWS AUTHENTICATION IN IS

Windows Server

2008 (IIS 7):

http://technet.microsoft.com/en-us/library/cc754628%28v=ws.10%29.aspx

Windows Server

2003 (IS 6):

http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/11S/5f8fe119-

4095-4094-bbab-7dec361c7afe.mspx?mfr=true

Example for IS 7:

Open the Internet Information Services (IIS) Manager and browse to your MCweb

instance:

“E Internet Information Services (IIS) Manager R

=lolx]

@é‘) [ @ » penpcizoss

b Sites » DefaultWebsSite » MCWEB730 »

| s @ -

Fle View Help
2|

£ &) Default Web Site =
% Mcwes730

LE|
Filter: - Bfico - lshshow Al |Groupby: Area - -
ASP.HET =
P &4 = i Ive o
. E B © & 4
2 = @ B ® A 5§
NET NET .NET Error NET .NET Profile  .METRoles  .METTrust  .NET Users
Authorizati... Compilation Pages Globalization Levels
= ;l? — [
= ab| ks = .QE) 8@
Application  Connection  Machine Key  Pagesand  Providers  Session State  SMTP E-mail
Settings Strings Controls
s
ASP cal Compression  Default Directory  Error Pages
Document  Browsing
= =) =, U | = -
% = L) fg ﬂ =1
FaledRequest  Handler  HTTP Redirect ~ HTTP IP Address Logging MIME Types  Modules
Tradng Rules  Mappings Respo... and Dom...
E &0 o= -}
s =
Output Request  55LSettings  WebDAV
Caching Filtering Authori. .. |
Management

il

4 |

Ready

| =] Features view |\ = Content View

Open Feature

42 Explore

Edit Permissions...
[E] Basic settings...

View Virtual Directories
Manage Application 0]

Browse Application
Browse *:80 (http)

Advanced Settings. .

@ Help

Online Help

et

Locate the feature ,Authentication and open it:


http://technet.microsoft.com/en-us/library/cc754628%28v=ws.10%29.aspx
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/5f8fe119-4095-4094-bba5-7dec361c7afe.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/5f8fe119-4095-4094-bba5-7dec361c7afe.mspx?mfr=true
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" Internet Information Services (IIS) Manager i [m] 3]
6&3\ [3 » DEN-PC12-035 b Sites » DefaultWebSite b MCWEB730 b ]Q} e -

Fle View Hep

(Comectons
&) Authentication

# | [E, Enable
B4 Default Web Site &

3 R Group by: Mo Grouping = I
Name = | status | Response Type | Oriine Help
‘Anonymous Authentication Enabled
ASP.NET Impersonation Disabled
Basic Authentication Disabled HTTP 401 Challenge
Digest Authentication Disabled HTTP 401 Challenge

Forms Authentication Disabled HTTP 302 Login/Redirect

Authentication Disabled HTTP 401 Challenge

4 | _’l_l [ =7 Features view |/ Content View

Configuration: 'localhost applicationHost.config , <location path="Default Web Site/MCWEB730"> €.

Here the option ,Windows Authentication* is listed. In the top right corner the function
could be enabled.

Note: The Windows Authentication is not visible if the Webserver is not connected to a
domain.
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ADJUSTING WEB.CONFIG

The Web.config needs to be adjusted to force client authentication on the LDAP Login
page. This is necessary because “anonymous” access (via regular Materials Control
user/password) to the application should still be allowed in general, and the browser/client
does not send any authentication information by itself, unless it is explicitly forced to do
Sso.

This can be accomplished in two ways:
1. Use the default Web.config supplied in the MCweb installation package

a. Make a backup of the original Web.config
b. Overwrite the original with the default included in the package

c. Copy the entire <appSettings> section from the backup and overwrite the
empty/default values of the new Web.config

2. Alternatively, if the Web.config contains other adjustments besides
<appSettings> that should not be lost, the new section can be added manually

a. Open the default Web.config and scroll to the bottom
b. Locate the <location path="LDAPLogin.aspx"> ... |</location> section

c. Copy the entire section to the original Web.config

-0l

File Edit Format View Help

newversion="2.5.0.0" /> |
</dependentassembly>
<dependentassembly>
<assemblyIdentity name="System.web. Extensions.Design”
publickKeyToken="31bf3856ad364e35" />
<bindingredirect oldversion="1.0.0.0-1.1.0.0"
newversion="3.5.0.0" />
</dependentassembly>
</assemblyBinding>
</runtime:>

authorization
eny users
allow user

</ CONTIgurations=

Save & close the file.

Restart the 1IS service using the command IISRESET.
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ACTIVE DIRECTORY (LDAP) LOGIN PAGE

The LDAP Login page can be reached via the URL:
http://<WebAppURL>/LDAPLogin.aspx

If the Web.config is configured to allow connection to multiple databases, the
Company/DB to log in to can be supplied as URL parameter:
http://[<WebAppURL>/LDAPLogin.aspx?company=DBName

In general the LDAP Login page functions and looks similar to the regular login page:

MICros

Materials Control

Company I 'l

The “User” field in this case contains the read-only “DOMAIN\Username” that needs to be
entered in the User Management module for a successful user mapping, and of course
varies depending on the user who visits the site. If no valid authentication (data delivered
by the browser) can be acquired, the user is automatically redirected to the regular login
page.

In the ideal case the user will not even see this page and be logged in seamlessly, but
this depends on the information the user has provided and of course whether the login
itself was successful.

The user will see this page, if:

» Anunrelated error happened during login (DB connectivity, etc.)

» The current Domain user is not mapped to a Materials Control user on the
selected DB.

» Multiple databases/Companies are configured in Web.config, but nho Company
was supplied via URL parameter



micros

BROWSER SUPPORT

Both Firefox and Internet Explorer support Active Directory (LDAP) authentication,
however there is a caveat when using Firefox; unlike IE, Firefox does not automatically
have access to the user credentials of the currently logged on Windows user — instead,
upon visiting the LDAP Login page, the browser will ask the user for his Windows
credentials once®, which are then used for the LDAP authentication:

Authentication Required ﬁ
e Enter usernarme and password for http://portaléd.delegate-group.com
User Mame: |

Password:
[ OK l | Cancel |

L

If the user clicks Cancel he will be redirected to the regular login page. Note that this
authentication prompt is a built-in browser feature and cannot be influenced by the Web
application.

The credentials will be saved/cached until the browser is closed.

MICROS-FIDELIO GmbH

Europadamm 2-6

41460 Neuss

Germany

Phone: +49 2131-137 0 | Fax: +49 2131-137 777

! The credentials will be saved/cached until the browser is closed.



	Introduction
	General Requirements:
	Supported RDBMS:
	Required Installation Files:

	Setup:
	Creation of Directories:
	Web Service Directory:
	web.config Settings
	Infragistics Directory:

	IIS Configuration:
	Install Infragistics:
	Create Application:

	Report Logo:
	Recipe Pictures:
	Picture Storage:
	IIS Configuration:
	Web.config Adjustments:

	Document Attachments:
	How to Speed up your ASP.NET application
	How to extend the Internet Explorer Session Timeout

	Troubleshooting:
	Error Log File:
	Error on first time choosing ORDERING I:
	Error on first time choosing ORDERING II:
	Open Orders not shown in Receiving:
	Pages not refreshing:
	Oracle 10g settings
	Connection Error

	Domain User Support
	FMLOGIN.INI:
	User Configuration:
	Using the Thick Client:
	Using the MCweb Client:
	Pre-requisites:
	Overview:
	ENABLING WINDOWS AUTHENTICATION IN IIS
	ADJUSTING WEB.CONFIG
	ACTIVE DIRECTORY (LDAP) LOGIN PAGE
	BROWSER SUPPORT




